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Suzie Campbell takes the helm at the OPA

Suzie Campbell, publisher
of the Countywide & Sun in
Tecumseh, officially assumed
the role of president of the
Oklahoma Press Association
(OPA) on July 1.

OPA members elected
Campbell during the associa-
tion’s annual business meet-
ing, held June 6-7 at the OPA
Convention in Shawnee. She
succeeds Shauna Belyeu and
will serve a one-year term as
president.

Before her newspaper
career, Campbell held various
positions, including nearly 10
years at Tinker Air Force Base.
She also worked at an attor-
ney’s office and OU Health
Sciences Center before open-

Key card swipes are public

Oklahoma Attorney
General Gentner Drummond
issued an opinion stating that
employees’ key-card access
to buildings is an open record
subject to disclosure under the
Oklahoma Open Records Act.

“The public has a right to
know whether our elected of-
ficials and the people they hire
are showing up for work,” said
Rep. John Waldron, D-Tulsa,
who requested the opinion.

The opinion states that

;A R

OPA President Suzie Campbell
ing her own business, Magic
Memories, in late 2004. She
began working part-time at the
Countywide & Sun in 2005.

“In March, my mother saw

an advertisement for a graphic

a news organization sought
records from an agency of one
person’s key-card entry into
the building for the years 2023
and 2024. The agency denied
the request, claiming an Open
Records Act exception relating
to terrorism and security mon-
itoring permitted the agency to
keep the records confidential.
AG Opinion 2025-9 states
that if portions of the record
are subject to an exception
of the Open Records Act, the

www.OkPress.com

artist at the Countywide. I
faxed a resume to then-owners
Gloria and Wayne Trotter, and
Gloria called me for an inter-
view,” said Campbell.

Although she told the
Trotters that she only averaged
about five years at a job before
she became bored and began
looking for something new,
she was hired immediately.

“In August of that same
year, I went full-time, and I
can honestly say I have never
been bored.”

At the Countywide & Sun,
Campbell worked as a graphic
artist, advertising sales rep,
circulation manager and in
accounting.

The Trotters tried to

public body must “redact the
information that is exempt
from disclosure and allow
access to the remainder of the
record.”

The official Opinion of the
Attorney General states: “A
data log that reflects employ-
ees’ use of key-cards to access
a public body’s building is
an open record subject to dis-
closure under the Oklahoma
Open Records Act. If portions
of the record are subject to

www.Facebook.com/okpress

convince her to purchase the
paper over the years, but it
wasn’t until March 2017 when
they received an offer from
someone else that Campbell
decided to buy it.

“The newspaper had always
been locally owned, and I
wanted it to stay that way,”
she said.

On April 1, 2017, Campbell
became owner and publisher
of the Countywide & Sun.

“I thought I knew what
I was getting into, but there
is so much more that I still
have to learn. Thank goodness
Wayne and Gloria are still a
phone call away, and Brian
Blansett [publisher of The Lin-

Continued on Page 3

records

an exception to the ORA, for
instance in title 51, section
24A.7 or 24A.28 of the Okla-
homa Statutes, and the exempt
information is ‘reasonably
segregable’ from the rest of the
record, the public body must
redact the exempt informa-
tion and provide access to the
remainder of the record.”
(Read AG Opinion 2025-9
at oklahoma.gov/oag/opinions/
ag-opinions/2025/2025-09 .html)
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Weatherford Daily News files FOIA request
over $50,000 settlement to local police officer

The Weatherford Daily
News has filed a Freedom
of Information Act (FOIA)
request seeking records related
to a $50,000 payment made
by the City of Weatherford to
Officer Joseph Cox.

Cox, who has served as
president of the local police
union since 2022, was the sub-
ject of a settlement discussed
by city commissioners during
a special meeting held in
executive session. Details sur-

rounding the payment remain
unclear.

In response, staff members
from the Daily News submit-
ted FOIA requests to the may-
or, city attorney and city clerk.
The requests seek access to
all settlement agreements and
meeting minutes involving the
City of Weatherford — or any
of its departments, agencies,
employees, or representatives
— that were funded in whole
or in part by public dollars

between January 1,2025, and
December 31, 2025.

The newspaper’s goal is to
provide transparency regard-
ing the use of taxpayer funds.

“We filed the request
because we believe the public
deserves the right to know
why the city gave Joseph Cox
$50,000 out of the taxpayers’
pocket,” said Phillip Reid,
publisher and owner of Reid
Newspapers.

Shawnee News-Star hosts student awards gala

The Shawnee News-Star
presented awards to students
in grades 9-12 at its annual
Best of Tri-County Area Preps
gala on June 3.

This is the ninth year The
News-Star has sponsored the
event.

CherryRoad Media Chief
Operating Officer Lee Bachlet
spoke at the event about the
work involved in putting
together and hosting such a
major awards program for
local students and athletes.
CherryRoad owns the News-
Star.

Bachlet reminded the
approximately 500 guests in
attendance that The News-
Star needs the community to
support the local newspaper
through their subscriptions.

He encouraged attendees
to become subscribers to The
News-Star for coverage of lo-
cal news and sports, as well as
support of the Preps program
and gala.

At Preps 2025, The News-
Star awarded nearly $12,000
in scholarships and prizes.

Preps honors local stu-
dents from all 14 public high

schools in The News-Star’s
coverage area: Asher, Bethel,
Chandler, Dale, Earlsboro,
Macomb, Maud, McLoud,
Meeker, North Rock Creek,
Prague, Seminole, Shawnee
and Tecumseh.

Local sports writers select
athletes; A board of local
community leaders selects
Students of the Month and
Student of the Year based on
the submissions from high
school administrators.
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OPA CALENDAR
OF EVENTS

For more information
on upcoming events visit

okpress.com/events

JULY 24

1:00 —2:00 PM

OMC WEBINAR: Al Agents for
Summarizing Public Meetings
The team at Our Hometown will
demo the latest updates to their Al
Summarizer for Public Meetings.
The Al app has been repackaged
into a WordPress Plugin that auto-
matically checks selected YouTube
channels for new meetings and
generates a summary. It is now be-
ing beta tested and will be available
to all publishers soon.

JULY 31

1:00 - 2:00 PM

OMC WEBINAR: How We
Doubled Our Subscription Price
and Lived to Tell the Tale

Almost two years ago, Joey and
Lindsey Young, co-publishers of
Kansas Publishing Ventures in
south central Kansas, put their
company in the hands of three
university researchers and took
the plunge to try new ideas for rev-
enue with their flagship community
weekly, Harvey County Now. Hear
all about the experiment, how
these ideas transformed their busi-
ness in unexpected ways and how
you can use what they learned in
your own newsroom.

SEPTEMBER 18
2:00-3:30 PM

NA WEBINAR: Become a Photo-
shop Guru with Kevin Slimp
Hold on to your seats! This is
going to be one incredible class,
filled with information that will

take you from wherever you are to
“Photo Editing Guru” status in 90
minutes!

OCTOBER 16

2:00 - 3:00 PM

NA WEBINAR: Getting More
People to Pick Up Your
Newspaper with Kevin Slimp
Kevin Slimp has traveled from
coast to coast and border to
border visiting with community
newspapers planning for growth.
Now you can learn some of what
Kevin has learned in his travels
over the past few years and find
new ways to get people to pick up
your newspaper.




Shonda Crowdis Little is
the new editor of the Ellis
County Star, announced Dub
Wagnon, publisher of the
weekly newspaper.

Little began her jour-
nalism and writing career
in 2003 at the Elk Citian
but has also worked at the
Beckham County Record,
Elk City News, GoWest

Ellis County Star names Shonda Little as editor

magazine, Western Ag mag-
azine, BlogHer, and National
Public Radio.

Wagnon said Little
covered crime extensively
in Beckham County as well
as hard news and feature
stories.

“For those reasons and
many more, she was a great
pick to help me continue to

grow the Ellis County Star
into a weekly newspaper
that has something for every
citizen every single week,”
Wagnon said.

Little said that it’s re-
freshing to have her name
on a newspaper that has the
primary goal of covering
western Oklahoma.

OPA President

Continued from Page 1

coln County News] is a great
friend and mentor.”

Campbell said her goal af-
ter graduating from Dale High
School in 1982 was to own
her own business.

“I never dreamed it would
be a newspaper. Now, I can’t
imagine doing anything else.
Newspapers are still the best
source for local news,” she
said.

As a professed tech nerd,
Campbell embraces the digital
format of newspapers while
still holding tight to the print
version.

“We have very diverse
generations to serve. We have
the older generation, who still

cling to the printed paper, and
the younger generation, who
are all about the digital. As
news leaders in our commu-
nities, we need to embrace
the digital tools available to
reach our younger citizens,”
Campbell said.

As the newly elected
president, Campbell said she
is looking forward to visiting
with other OPA members to
discuss their ideas, needs and
challenges.

Other officers elected for
one-year terms at the business
meeting were Erin Dyer-
Thompson, co-publisher of
the El Reno Tribune, as vice
president; Brian Blansett, pub-
lisher of The Lincoln County
News, for a second one-year
term as treasurer; and Shauna

Belyeu, general manager of
The Eufaula Indian Journal, as
immediate past president.

The membership also
renewed a three-year term on
the OPA Board of Directors
for Ed Choate, publisher of the
Muskogee Phoenix. Connor
Choate, co-publisher of the
Marietta Monitor, and Jason
Collington, editor of the Tulsa
World, were elected to fulfill
vacated terms.

Katherine Miller, publisher
of The Norman Transcript,
was elected as a new board
member serving a three-year
term.

Other members of the OPA
Board of Directors are Brett
Wesner, Wesner Publications,
and Shaun Witt, Oklahoma
Watch.

a press release?

You've Got Questions!

Can | photograph minors without consent?
Can police deny access to records by issuing

Should | alter my archives when a person demands it?
Can | report inaccurate testimony given in open court?
* What are the laws about liquor advertising?

These are questions answered by the attorneys for the OPA Legal Services
Plan members in recent months. OPA members always need timely legal
advice on issues related to publishing.

You should join OPA’s LEGAL SERVICES PLAN!

See www.OkPress.com/LSP or contact Mark Thomas
at (405) 499-0033 or toll-free in Oklahoma 1-888-815-2672 today!
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Regular meeting of OPA Board of Directors
held during OPA Convention in Shawnee

The Oklahoma Press Asso-
ciation Board of Directors met
June 6 during the OPA Con-
vention at the Grand Casino
Hotel & Resort in Shawnee.

Officers attending were
President Shauna Belyeu,
The Eufaula Indian Journal;
Vice President Suzie Camp-
bell, Countywide & Sun; and
Treasurer Brian Blansett, The
Lincoln County News.

Directors attending were
Past President Sheila Gay,
Woodward News; Erin Dyer
Thompson, El Reno Tri-
bune; Ed Choate, Muskogee
Phoenix; Shaun Witt, Okla-
homa Watch; Connor Choate,
Marietta Monitor; and Jason
Collington, Tulsa World. Brett
Wesner, Wesner Publications,
was unable to attend.

Staff at the meeting was
Mark Thomas, Executive
Vice President/Secretary, and
Lisa Sutliff, CAE, Member
Services Director. Katherine
Miller, The Norman Tran-

script, attended the meeting as
a guest.

After calling the meeting
to order, Belyeu asked the
board to review minutes of
the April 10, 2025, meeting.
The minutes were approved as
presented.

Treasurer Blansett called
on Thomas to review the OPA
and LSP financial statements
ending April 30, 2025. Thom-
as said OPA currently has a
profit but expenses for the end
of the legislative session and
convention will occur in June.
LSP has a loss due to an ex-
pensive defense case this year,
as well as a revenue decline.
A reform to the Legal Ser-
vices Plan benefits and dues
structures is needed to sustain
the program in the future, said
Thomas. The board acknowl-
edged receipt of the OPA and
LSP financial statements as
presented.

Thomas also discussed two
capital expenditure requests

for the OPA building to be
completed in the next few
months —a $1,710 skylight
replacement and conversion
of more than 300 fluores-
cent light fixture ballasts at a
cost of $2,839.17. The board
approved recommendations
of the two capital expenditure
requests as presented.

MEMBERSHIPS
APPROVED

The board unanimously
approved affiliate news media
membership applications for
The Mabel Bassett Balance
and The Warrior Standard.
Both applications were
submitted by Poetic Justice
organization out of Tulsa. The
Balance is published quarterly
at Mabel Bassett Correctional
Center in McLoud and distrib-
uted to the community living
and working at the center.
The Standard is published
quarterly at Eddie Warrior
Correctional Center in Taft

and distributed to community
members living and working
there. Notices of application
were published in the May
issue of the Publisher.

COMMITTEE
REPORTS

In the Government Re-
lations Committee update,
Thomas reviewed a list of bills
impacting OPA members from
the 2025 legislative session
including passage of HB 2167,
which increases the fees for
public notices for the first time
in 20 years. The bill passed the
House and Senate with over-
whelming majorities but was
vetoed by Gov. Stitt, along
with many other bills. On the
last day of the 2025 session,
the House and Senate voted
to override the veto. The new
rates in HB 2167 will take
effect on Nov. 1, 2025.

The board congratulated
and thanked Thomas for his

Continued on Page 5
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Tishomingo Mayor Laura Wood urges

residents to stop relying on social media

Tishomingo Mayor Laura
Wood recently urged city res-
idents to stop turning to social
media for information about
city business.

In a page 1 story in the
July 9 edition of the Johnston
County Sentinel, Managing
Editor John A. Small reported
that Wood labeled some of
that information as deliberate
lies being spread by individ-
uals with their own personal
agendas.

Small said the mayor was
speaking in her role as chair
of the Tishomingo Munici-
pal Authority (TMA) at the
board’s regular meeting when
she responded to recent criti-
cism posted on Facebook that
claimed that TMA funds are
being improperly used.

Much of the criticism cen-
tered around allegations that

TMA funds were being used
on projects such as the recent
construction of a park.

“Wood categorically denied
those allegations, noting that
such use would be illegal, and
that the allegations are easily
disproven by a simple review
of documents that are on file
at City Hall and available
for public inspection,” Small
wrote.

Although the TMA is
comprised of the same mem-
bership as the city council,
the TMA board is a separate
entity. Its funds are limited to
use on infrastructure needs,
contrary, Wood said, to claims
being made on social media.

“Anyone who has questions
should call City Hall, instead
of getting their ‘information’
from the lies being spread on
social media,” Wood said.

“The press is the best instrument for enlightening the mind of man, and
improving him as a rational, moral and social being.” - Thomas Jefferson
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Mayor to residents: ‘Stop relying on social media’
Wood calls recent Facebook criticism ‘deliberate lies’
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Small wrote that her sen-
timents were echoed by City
Manager Bryce Jones, who
said that the city’s final budget
report for Fiscal Year 2024-25,
which shows city expenditures
from both TMA and general

budget funds, has been posted
on the city’s website and can
be reviewed by anyone wish-
ing to do so.

“It’s all right there to see
for anyone who takes the time
to look,” Jones said.

Board Meeting

Continued from Page 4

diligent efforts on HB 2167.
Thomas said dormant bills
could be alive next year, in-
cluding HB 2166, authored by
OPA to modify the definition
of a legal newspaper, among
other modernization efforts.

Thomas also discussed HB
2163, which created the Public
Access Counselor (PAC) posi-
tion in the Oklahoma Attorney
General’s Office. The PAC
position serves both records
custodians and requesters to
determine whether records
are open or closed, aiming
to avoid legal action. Many
public bodies opposed the bill,
and Gov. Stitt vetoed it; how-
ever, the legislature overrode
the veto on the last day of the
session.

SB 535, which modifies the
Open Records Act, passed into
law without the governor’s sig-

nature. It allows a public body
to require advance payment
of estimated fees for records
requests if those fees are ex-
pected to exceed $75. Thomas
said the public may review the
original pages before being
charged for copies.

Chairman Connor Choate
encouraged the Board and
committee to seek ways to
keep the Legal Services Plan in
a healthy financial position. An
active lawsuit under Plan B has
been assigned to the Court of
Civil Appeals to reach a deci-
sion. The case has reached the
$20,000 limit to Plan B; how-
ever, if the case is overturned
on appeal, LSP will have the
right to recoup attorney fees.

OTHER BUSINESS

In other business, Thomas
and the board thanked outgo-
ing president Shauna Belyeu
and outgoing past president

Sheila Gay for their service on
the board.

OPS BOARD MEETING

President Belyeu asked
board members to review the
minutes of the April 10, 2025,
meeting. The minutes were
approved as presented.

Thomas reviewed the OPS
financial statements for the
period ending April 30, 2025,
and said net income is project-
ed to be lower than budgeted at
the end of the fiscal year. The
board acknowledged receipt of
the statements.

Following the management
review session, Belyeu said
the board appreciates Thomas’
work to improve the industry.
The board also complimented
Thomas, Sutliff and the staff
for their passion and thoughtful
actions that benefit members.

Transcript
names new
sports editor

Davis Cordova is the
new sports editor at The
Norman Transcript.

He previously covered
sports for The Express-Star
in Chickasha as well as
surrounding communities.

Cordova graduated in
May 2024 with a Sports
Media degree from the
School of Media and Stra-
tegic Communications at
Oklahoma State University.

While in school, he
worked at The O’Col-
ly, OSU’s independent
student newspaper, where
he covered OSU football,
women'’s basketball and
baseball.
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—Speed Topics—

A few presenters from the Speed Topic

sessions at the June 6-7 OPA Convention
shared their ideas with us. Take a look at all
the great information they provided! Also, see
Wilma Newby’s Photoshop tips on Page 14.

Developing Sustainahle Ad Packages

presented by SEAN STEPHENS, CLINTON DAILY NEWS

When a local
advertiser racked up
more than $3,000
in unpaid bills and
then balked at the
thought of a month-
ly payment, the
fallout was costly:

a $17.,000 account
gone.

But instead of
stewing in frus-
tration, Sean Stephens, publisher of the
Clinton Daily News, turned the loss into
motivation, launching what he called the
“$17,000 plan.”

“I got mad, but then I got motivated,”
he said. “I started thinking: how do I
counter that? And more importantly, how
do I blow it out of the water?”

The answer: sustainable, relation-
ship-driven advertising packages that offer
daily visibility and built-in value across
the entire publication year. These pack-
ages include features such as daily sports
page placement, branded game updates,
bundled obituary coverage and custom
placements on under-utilized pages, in-
cluding classifieds.

For example, one funeral home pays a
flat monthly rate that includes all obituary
notices. It’s a move that not only helps

grieving families but drives daily relation-
ships.

“We’re not just selling space. We’re
fostering long-term relationships,” Ste-
phens explained. “Our job is to help local
businesses make a lot of money and make
a little for ourselves in the process.”

Stephens emphasizes flexibility, sim-
plicity and fairness over rigid contracts.

Most advertising packages operate
on handshake agreements and are billed
monthly with detailed line-item invoices
showing each inclusion, from a graduate
edition to a Kid’s Scoop sponsorship.

“It’s a partnership,” he said. “If they
don’t succeed, we don’t succeed.”

The most important step in the sales process

presented by CARRIE CARBERRY, SEQUOYAH COUNTY TIMES

Carrie Carber-
ry reminded her
peers of a powerful
truth: newspapers
remain one of the
most trusted and
vital sources of
information in their
communities — if
only they remember
their value.

“We believed the
national narrative that newspapers were
dying,” she said. “But when Covid hit,
people didn’t turn to social media; they
turned to us.”

Carberry, who is advertising manager at
the Sequoyah County Times, urged news-
paper teams to lead with confidence. When
sales representatives walk into a business
unsure or discouraged, that uncertainty is
evident, she said.

“But when we know our value, we
don’t just hear ‘no’ and walk away. We
ask, “Why? What are you looking for?’
Because we can help meet that, whether in
print, digital, or both.”

A standout example was the newspa-
per’s treasure hunt promotion, where the
publication partnered with local businesses
to give away a treasure chest full of prizes.
The staff distributed keys to businesses

that readers receive when they make a
purchase. The campaign brought in foot
traffic, boosted ad revenue and reminded
people that the paper was still alive, rele-
vant, and creative.

Crucially, she emphasized that news-
papers don’t just sell ad space; they build
community.

“I don’t want just to take your money.
I want your business to be open next year.
We grow together,” she said.

Carberry’s call to action was simple but
powerful: Believe in what you do because
your communities still do.




Knock it off!

Five things you should immediately stop writing

presented by TED STREULI, OKLAHOMA WATCH

Great journalism
demands clarity,
relevance, and
purpose. Yet, too
often, reporters fall
back on routines
that do more to fill

space than inform
readers, Ted Streuli
told members of
the press during
his Speed Topic
session.

It’s time to break the habits that weaken
your storytelling, said Streuli executive
director of Oklahoma Watch.

Covering a public meeting doesn’t
mean publishing a minute-by-minute

recap. Instead, focus on the debates,
decisions, and consequences that matter
to your community. Press conferences,
too, can be misleading distractions, Streuli
continued. “Unless you know the event
will deliver real news, your time is better
spent reporting on meaningful develop-
ments,” he said.

Regarding quotes, Streuli said they
should add value, not noise. “When public
officials or spokespeople give vague, eva-
sive answers, press them again or report
their refusal to answer. Don’t let empty
words take up valuable column inches.
Likewise, avoid letting personal anecdotes
dominate your work. While it’s tempting
to draw from your own life, your readers

care more about issues that affect them
directly.”

Cluttered storytelling weakens the
impact of your work, he said. “Just like a
good soup, only include the most potent
ingredients; trim unnecessary quotes,
repetitive backgrounds or tangents. Skip
the jargon and avoid tired cliches,” he
advised.

Streuli also urged journalists to beware
of political statements that sound nice but
say little; push for substance; and, most
importantly, craft strong leads. Ditch the
metaphor-laden intros and get straight to
the heart of the story.

Streuli said elevating your journalism
isn’t about working harder; it’s about
being sharper.

Showing up where the potential audience is today

presented by JASON COLLINGTON, TULSA WORLD

“Stop relying
on tradition or fill-
er,” he said. “Start
building trust and
engagement by
delivering reports
that truly inform,
challenge and
connect.”

In today’s
fractured media
landscape, the path
to growing audience trust isn’t paved with
branding; it’s built through relationships,
said Jason Collington, editor of the Tulsa
World.

Many potential readers and subscribers
don’t become customers simply because
they never have the opportunity to meet

Oklahoma Watch Executive
Director Ted Streuli leads a Speed
Topic session at the June 7 OPA
Convention in Shawnee. Streuli
discussed how to write meaning-
fully by focusing on what readers
care about. The Speed Topics
sessions featured three 20-minute
rounds with five topics in each
segment to choose from.

you. They haven’t had the chance to trust
you, like you or even know what you
offer, he said.

The strategy is clear: stop pushing your
brand and start building your reputation.
Collington said journalists and media
leaders must literally get personal. Instead
of expecting audiences to find their way to
traditional platforms, it’s time for news-
rooms to meet people where they are. That
means leaving the newsroom and stepping
into real and digital spaces where disen-
gaged communities live.

Companies need to have more human-
ity and make personal invitations. Offer
access and insights in ways that showcase
your value beyond headlines, Collington
suggested. This involves getting in their
ear through video and audio podcasts,

landing in their inboxes with curated and
personalized email newsletters and finding
your way, he said. The old ways are not
working.

The truth is that institutions don’t build
trust; people do, he continued. Journalists,
often the most informed people in any
room, should lean into that credibility —
not through opinions but through authen-
tic, personalized fact-sharing.

Collington said it’s time to stop relying
on yesterday’s strategies because they’re
not working.

But by showing up personally and
consistently, media leaders can reintroduce
themselves to the communities they serve
and help audiences rediscover the impor-
tance of journalism, he concluded.
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APRIL 2025 WINNERS

Daily, Semi- and Tri-Weekly Photo Winner:

BILLY HEFTON
Enid News & Eagle

Column Winner:

ALLIE PRATER

Cushing Citizen

Adventures with Allie:

Living with History

We like to think of history as something kept behind
glass. Something that is protected by experts, preserved
by grants, catalogued by committees. But in truth, the
preservation of a town’s character and history doesn’t
rest solely on the shoulders of a historical society or
a town council. It lives in the everyday choices we all
make. Preserving the spirit and soul of a small town is
everyone’s job.

As someone who has always lived with history all
around me, these thoughts are not just the ramblings
of someone who thinks older buildings are nifty, these
are the thoughts of someone who has been inside of a
home built by Pueblo Indians centuries ago ...

All entries judged by members of the Oklahoma Journalism Hall of Fame

Weekly Photo Winner:
MATT SWEARENGIN

Durant Democrat

OGE Energy Corp. provides monthly winners with a $100 check and
certificate. Sweepstakes winners receive $200 and a plague from OGE.
Contest open to staff at OPA Legal Newspaper and General News Media
members, as well as OPA Individual members.
Complete contest rules and online submission form
available at okpress.com/oge-photo-contest.

View winning photos at okpress.com/
oge-photo-contest

Editorial Winner:

KIM POINDEXTER
Tahlequah Daily Press

Mullin’s ‘joking’ threats
are no laughing matter

Anyone who has been in the presence of Sen. Markwayne
Mullin - like the journalists he “jokingly” threatened
a few days ago — may be reminded of a banty rooster,
crowing and strutting in a hen yard, and praying the
bigger, tougher Rhode Island Red won’t come flapping
his way.

Mullin’s latest round of blustering came over the
weekend via a video on X, the platform formerly
known as Twitter. He suggested journalists might
produce “less false stories” — technically, “fewer” is the
right word, not “less” — if the violence used back in the
day to settle differences returned to the fore.

Oklahoma Natural Gas provides monthly winners with a $100 check and certificate. Sweepstakes winners receive $200 and a plaque from ONG.
Contest open to staff at OPA Legal Newspaper and General News Media members, as well as OPA Individual members.
Complete contest rules and online submission form available at okpress.com/ong-contest.
Views expressed in winning columns and editorials are those of the writers and don’t necessarily reflect the company’s opinions.

Read winning columns and editorials at okpress.com/ong-contest



MAY 2025 WINNERS

Daily, Semi- and Tri-Weekly Photo Winner:
ANDY DOSSETT

Bartlesville Examiner-Enterprise

All entries judged by members of the Oklahoma Journalism Hall of Fame

Weekly Photo Winner:
DEANNA MADDOX

Yale News

OGE Energy Corp. provides monthly winners with a $100 check and certificate. Sweepstakes winners receive $200 and a plaque from OGE.
Contest open to staff at OPA Legal Newspaper and General News Media members, as well as OPA Individual members.
Complete contest rules and online submission form available at okpress.com/oge-photo-contest.

View winning photos at okpress.com/oge-photo-contest

Column Winner:

ALLIE PRATER
Cushing Citizen

Editorial Winner:

DAVID STRINGER
The Lawton Constitution

Adventures with Allie:

See you from the stock tank

There’s nothing quite like being 8 months pregnant
at the start of summer. The world is warming, flowers
are blooming, and my ankles have vanished without a
trace.

People keep telling me, “You’re glowing!” And
I appreciate the sentiment, but I feel more like I'm
simmering. I’'m not so much glowing as steaming, like
a dumpling left too long in the basket. My internal
thermostat is broken, the baby has taken over all my
vital organs, and I’ve developed a deep and personal
relationship with my hand-held fan.

Don’t get me wrong, I love this baby, I absolutely
do. But growing a human while nature simultaneously
tries to roast me like a rotisserie chicken is a test I did
not study for. My doctor says I should take walks. Out-
side. In Oklahoma. In May. That’s adorable.

I waddled to the car yesterday morning, planning on
going to the park for a walk and nearly melted into a
sidewalk puddle.

GPIF settlement still leaves

lots of unanswered questions

At least one chapter of the sad demise of the Great
Plains Improvement Foundation came to a close last
week as the City of Lawton settled a claim related to
Section 8 properties that were improperly sold by the
foundation.

It’s a complicated mess, but the gist of it is GPIF
owned the properties and the city was the transferring
entity which moved federally-designated funds for
low income housing to the foundation to support the
program’s goals. One of the restrictions of taking those
monies was the properties couldn’t be sold without
permission from the city. The City of Lawton held liens
on the properties through HUD-backed mortgages.

When a lien’s filed, there’s supposed to be a record
at the county. When a property is involved in a sale,
it’s routine that the buyer’s representatives (or lender)
check the title over to make sure there are no liens and
that the title is free and clear. If you’ve ever bought or
sold property, you know the drill.

Oklahoma Natural Gas provides monthly winners with a $100 check and certificate. Sweepstakes winners receive $200 and a plaque from ONG.
Contest open to staff at OPA Legal Newspaper and General News Media members, as well as OPA Individual members.
Complete contest rules and online submission form available at okpress.com/ong-contest.
Views expressed in winning columns and editorials are those of the writers and don’t necessarily reflect the company’s opinions.

Read winning columns and editorials at okpress.com/ong-contest
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Stillwater News Press celebrates
historic move to the Berry House

cws Press (=8

405 8 T 2R 000

The Berry House at 502 S. Duck is the new home of the Stillwater News Press. (Photo by Jason Elmquist, Stillwater News Press. Reprinted with permission.)

he Stillwater News
Press marked a new
chapter in its history

with an open house and rib-
bon-cutting ceremony on June
12 to celebrate its relocation
to 502 S. Duck Street. The
newspaper’s new home is the
historic Berry House, built in
1908 and known for its dis-
tinctive architectural style and
connection to former Okla-
homa Lieutenant Governor
James E. Berry, who served
from 1935 to 1955.

During the celebration,
visitors had the opportunity to
tour the iconic residence and
learn about its rich past. Re-
freshments for the event were
provided by local favorite
Roscoe’s Feed Shack.

The Stillwater News Press

has deep roots in the com-
munity. It evolved from the
merger of multiple newspa-
pers, tracing its lineage back
to the Stillwater Advance,
established in 1892 — 15 years
before Oklahoma achieved
statehood.

The newspaper experienced
various ownership changes
over the years. In 1929, E.E.
“Hook” Johnson became
publisher, with C.R. Bellatti
and R.M. Bellatti joining as
part owners. Together, they
combined the Stillwater Daily
Press and the Stillwater Daily
News, forming the foundation
of today’s Stillwater News
Press. The Bellatti family
led the newspaper for more
than five decades until its sale
to Community Newspaper

Holdings Inc. (CNHI) in 1997.
CNHI remains the current
owner.

With its move to the Berry
House, the News Press begins
a new era, continuing its com-
mitment to local journalism
and community engagement.
Publisher Mike Kellogg em-
phasized the symbolic signif-
icance of uniting two historic
Stillwater entities.

“Our goal is to continue the
heritage that the Bellatti fam-
ily established,” Kellogg said.
“The Berry family also played
a major role in this communi-
ty, and we hope to honor that
legacy.”

Kimie Calcagno, Director
of Membership for the Still-
water Chamber of Commerce,
presented the News Press

with its official “first dollar”
of profit to mark the grand
opening.

“The Stillwater News Press
has long played a crucial role
in the community —sharing
stories that matter, informing
residents, and giving Stillwa-
ter a voice,” Calcagno said.

As the ceremony conclud-
ed, local nonprofit Wings of
Hope presented the newspaper
with a butterfly statue — a sym-
bol of hope and transformation
— promoting awareness of do-
mestic violence, stalking, and
sexual assault. The butterfly is
decorated with original comics
by artist Patrick Jalbert, with
funding provided by Dr. Rob-
ert Breedlove, a columnist for
the News Press.



LY i A

Wings of Hope Executive Director Brandi White and staff stand with Stillwater News Press Advertising Director
Katie Bean, Editor Beau Simmons, artist Patrick Jalbert, Dr. Robert Breedlove and Publisher Mike Kellogg at
the unveiling of a Wings of Hope butterfly on the grounds of the newspaper’s new location.

Photo by Jessica Marshall, Stillwater News Press. Reprinted with permission.
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Stillwater Chamber of Commerce Director of Membership Development Kimie Calcagno, right, presents Stillwater News
Press Publisher Mike Kellogg with a commemorative dollar marking the News Press’ move into a new location.

Photo by Jason Elmquist, Stillwater News Press. Reprinted with permission.

Journalism
vs. advocacy

Joe Hight, the endowed
chair of journalism ethics in
the Mass Communication
Department at the Univer-
sity of Central Oklahoma,
was recently asked by
Editor & Publisher to an-
swer this question: “When
does compelling journalism
become advocacy?”

Hight replied:

“Our mass communica-
tion program has media eth-
ics as a core curriculum in
both professional media and
strategic communication. ...
For our strategic commu-
nications graduates, they
may ultimately advocate
for their clients — what the
goals of that client are — in
contrast to a journalist, who
is not an advocate,” Hight
said, stressing that each
discipline should adhere to
ethical standards.

“I think that’s something
that needs to be stressed:
Ethics positively impacts
your credibility, your brand
and who you really want to
be. Ethics is an important
part of who you are.

“When you do good
journalistic work, good data
journalism, for example,
and when you tell stories
that compel people to act,
that has impact,” Hight
added. “That doesn’t mean
you have to be an advo-
cate for an organization. It
means your stories are ones
that people see as credible
and compelling enough
that they act because of it.

I think journalistic organi-
zations that consider social
issues important — criminal
justice issues, things like
that. Those types of stories
should have an impact.”

Read responses from
other experts on Editor &
Publisher’s website: https://
tinyurl.com/4498trxe.

Reprinted with permission
of Editor and Publisher
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Christmas in July
subscription sale

Reid Newspapers are cele-
brating Christmas in July with
a subscription special of a full
year of print and online for
half price.

The special not only gives
residents a great deal on stay-
ing informed, but also benefits
a local charity.

1/2 PRIBE
SUBSCRIPTONS

SPECIAL ENDS
JULY 377

Five dollars of every
subscription and subscription
renewal purchased during July
is donated to the local charity.

Reid Newspapers is a fami-
ly-owned group of newspapers
including Weatherford Daily
News, The Tribune (Bethany),
Delaware County Journal,
Nowata Star, Miami News-Re-
cord, The Grove Sun, Oologah
Lake Leader, Perry Journal,
The American, The Vinita
Daily Journal and The Grand
Laker.

Stigler News-Sentinel
readers search for keys

to open treasure chest

Readers of the Stigler
News-Sentinel are search-
ing for the key that opens a
treasure chest filled with gift
certificates and prizes from
local businesses.

PRSI
Jjum

:" g\‘ The Stigler News-Sentinel

has found a
TREASURE CHEST!
Legend has it that the Treasure Chest -
isfilled with a gift certificate for two recliners
from Wimberly's

To obtain keys, readers can
visit the newspaper office or
stop by participating business-
es to receive additional keys.

On July 21, individuals will
try the keys they collected to
open the treasure chest at the
News-Sentinel. Non-winning
key holders will be asked to
provide contact information
to be entered into a second
chance drawing that will be
held at the end of the contest if
the lock has not been opened.

Lawton Constitution invites readers to help
with recovery efforts in Kerr County, Texas

The Lawton Constitution invited its readers to donate to
The Community Foundation of the Texas Hill Country for the
recovery efforts in Kerr County, Texas.

“Kerrville is a fellow member of Southern Newspapers,”
said David Stringer, publisher of The Constitution. “So we
have a connection to those folks in ‘Hill Country.” Many
individuals have lost loved ones and everything they own and
if any of our readers had an interest in helping, we wanted to
point them in the right direction.”

The Kerrville Daily Times and The Lawton Constitution are
both owned by Southern Newspapers.

The Community Foundation of the Texas Hill Country is
a non-profit agency serving as a collection point for recovery
efforts.

Several newspapers ramping up

Readers’ choice award contests

Voting in the McAlester News-Capital’s annual Readers’
Choice Awards is wrapping up. The awards encompass more than
120 categories, enabling voters to select their favorite businesses
and recognize individuals. “We want to hear your opinion on the
best businesses in our community, so make sure to cast your vote
in our Readers’ Choice,” said News-Capital Publisher Reina Ow-

ns. “This is a fun time of year as people get excited to support
their favorite businesses, and it shines a light in our community.”

Also winding up its Best of Cherokee County Readers’ Choice
contest is the Tahlequah Daily Press. Voting in the Daily Press
contest is online only. An online aggregator tabulates nomina-
tions and final tallies. At the end of July, the Daily Press will
produce a magazine naming the winners.

Voting started July 16 in “The Best in the World” contest
created by the Tulsa World. This contest names the best of
everything in Tulsa in more than 150 categories. The five people
and businesses with the most nominations in each category ad-
vance to the voting round. The event where winners are named is
scheduled for September 11, with results being published in the
Tulsa World on September 14.

Learn the best practices for Public Notices at
okpress.com/public-notice-training

The Oklahoma Press Association offers three videos that describe and
illustrate the standards and best practices for publication of notices
along with downloadable material.




The Lawton Constitution keeps readers updated

Looking

Them Over
by Rod Serfoss
rserfoss @ okpress.com

The Lawton Constitution
does an excellent job keeping
readers in southwest Oklaho-
ma informed of what is taking
place locally and throughout
the world.
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COMING TUESDAY: Student led project cleans up Crosby Park neighborhood

Ft. Sill Indian School arch restoration complete
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Tyler Heffner is on the go
1

Lawton Public Schools
remain behind state averages

City of Lawton lacks historic
home preservati

While each edition contains
first-rate news, features, sports
stories and photographs, The
Constitution also has one of
the best opinion pages in the
state.

At the top of every Opinion
page, readers are reminded of
the right the First Amendment
of the U.S. Constitution gives
them and the press to express
their views.

“Congress shall make no
law respecting an establish-
ment of religion, or prohibit-
ing the free exercise thereof;
or abridging the freedom of
speech, or of the press; or the
right of the people peaceably
to assemble, and to petition
the Government for a redress
of grievances.”

And like any good news-
paper, its letter to the editor
policy invites others to express
their views by regularly
including, “The purpose of the

Opinion page is to provide a
forum of various viewpoints.
We encourage letters to the
editor ....”

It is a joy to read Lawton
Constitution Publisher David
Stringer’s thought-provoking
columns that often tell both
sides of issues and lets readers
form their own opinion.

In his recent column titled,
“Here a fee, there a fee ...,”
Stringer waded through Am-
azon being convinced by the
White House not to itemize
the cost of tariffs of goods it
sells.

After doing an excellent job
explaining the pros and cons,
he wrote, “I can see both sides.
If a product is going to cost
me substantially more today
than you quoted me last week,
I’d like to know why.

“On the other hand, these
things are getting a little out of
hand. I recall several years ago
when fuel prices spiked and
several of our newspaper ven-
dors applied a ‘fuel surcharge’
fee to our invoices. When pric-
es returned to normal, the fees
were still there.

“Likewise, when you pay a
‘convenience fee’ to pay your
bill electronically. Of course
they didn’t tell me who it was
convenient for.

“A lot of this is just the
cost of doing business these
days. Anything you buy from
overseas is going to cost more
if all the tariffs come to pass.
Whether you agree with the
policy or not, the question is
whether you want to see it
itemized,” concluded Stringer.

The Woodward News regu-
larly publishes a feature titled
“Someone you ought to know”
that highlights unsung heroes
in northwest Oklahoma.

The latest was an interest-
ing series about the person-
alities and careers of electric
power linemen that work in
the Woodward area.

Runners gather
for Lion Heart

Fort Supply Lake
outing hecomes
safety warning

for area family

The series reminded me of
the number of potential stories
writers see and then discard
every day. Reporters should
not forget that everyone has
a story to tell. If you wonder
what someone is doing or
what is taking place, your
readers are too.

Seeing potential stories
and then writing about them
is something the Woodward
News does well.

The Tulsa Beacon is a
great place to follow legisla-
tion flowing through the Okla-
homa State Capitol. It also
contains a large number of
personal columns and editori-
als that address a wide variety
of topics that are taking place
in the state, nation and world.

I especially enjoy the
Beacon’s circulation ad that
is highlighted by the iconic
picture of a TIRED OF
jubilant Harry FAKE NEWS?

Truman hold- >

ing a copy of
the Chicago
Daily Tribune
showing the
inaccurate
headline,
“Dewey De-
feats Truman.”
The Beacon ad proclaims,
“Tired of Fake News? Support
the Truth” — and includes a
coupon inviting people to sub-
scribe to the Tulsa Beacon.

-~ $'5 S
Support the Truth
TuLsA

T
918-523-44.

"
abeacon.com

A regular column in the
Logan County Courier, titled
Captain’s Corner, has elevated

the writer to celebrity status.
What makes it unique is the
famous columnist, Captain, is
a dog.

“Dad and Mom left us in
our room longer than Callie
thought we should have been
this morning, so she tore the
bed apart and ripped up the
sheets,” wrote Captain.

“So, you all know that my
uncle/brother, Frisky, and
I turned double digits last
Saturday! Frisky is not a fan
of getting his picture taken and
always has his ears flat down.
We had a great big birthday
party with hamburger birthday
cakes ... .

“Yesterday, one of my
dogtors called to check on me.
She wanted to know if the sup-
plements that she sent home
with me were helping. I’'m not
crying at night anymore, but
I’m still limping, some. Dog-
tor said that there are other
things she can try with me.”

Captain’s Corner

Speaking of things to try, a
fun column like the Captain’s
Corner could be a good place
to start.

TOP FIVE HEADLINES:

5. More than just a ‘dog
catcher’ — Perry Journal
4. A tale of heroes
— The Stilwell
Democrat Journal
3. ‘She was in tatters’
— Newkirk Herald Journal
2. ‘Breathtaking ignorance’
— Miami News-Record
1. Nude intruder
eats cake, takes a nap
— Broken Bow News

OPA Business Consultant Rod
Serfoss looks over OPA member
publications for “Looking Them Over,’
a monthly column. To contact

Serfoss, email rserfoss @ okpress.com.
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Simple ideas to improve photos for web printing

h Computer Notes
iﬁ from the road

' N | by Wilma Newby

M wnewby @ okpress.com

At the recent OPA Con-
vention, I discussed ways to
make photos print better on
newsprint. This month I’1l
share some of those tips with
all of you.

To start, set up Photoshop
in CMYK format, which
works better on newsprint.

In the Edit menu, go to Color

Settings and look for Working
Spaces. Click on the arrow at
right and go to Custom CMYK
at the top of the list.

In this box look under Ink
Options, then Ink Colors and
select SWOP (Newsprint). The
Dot Gain changes to 30%.
This percentage is how much
a drop of ink bleeds into the
absorbent newsprint. These
setting help the program know
what to do when making
the conversion from RGB
to CMYK. The medium we
are printing on is absorbent
instead of smooth-coated
stock. If you were printing
something like magazines,
you would change to a coated
stock setting.

The pressman where your
paper is printed may be able to
tell you the exact percentage
of bleed that works best with
that press.

Photos running on black-
and-white pages of the paper
should be turned to Grayscale
under Image > Mode > Gray-
scale. Doing this makes the

photo look better in the paper
and enlarged photos from
poor quality cameras will hold
more detail. Make this change
after lightening the photo to
the point that it will look good
in the paper. It may need to be
lightened once more after go-
ing to grayscale.

Now look for Lab color
under Image > Mode. When
going from RGB to Grayscale
try stopping on lab color and
using a Gaussian Blur on the
B Channel to get rid of noise
in bad quality photos. When
done, go to grayscale. This
often improves the photo quite
a bit.

The next step to creating
a quality photo for newsprint
is Image > Image size. If you
have a low-quality photo with
low resolution, image size
should be addressed early
in the correction process.
Resolution that can be held on
most web presses is 170 DPI,
but going higher will not cause
problems with photos. Many
papers use 300 DPI resolution
when trying to fix low quality
photos. Note the setting for
how it is going to re-sample
the photo at the bottom of the
box. Make sure it says best
for enlargement or, if you’re
reducing the size look for best
for reduction. This lets Photo-
shop do its best to improve the
photo.

If you’re going to run a
very large photo, consider up-
ping the resolution to 300 DPI
for photos that were 72 DPI
when opened. That 22-inch-

wide photo will look good

at 170 DPI when you bring

it down to around 11-inches
wide. Remember to change all
the settings in the image size
box at once so Photoshop can
work its best.

Another tip is to create a
folder of photos that print-
ed well in the paper on the
desktop of the person making
photo corrections to use as a
reference tool.

To examine the corrected
photos, use the info tool under
Window > Info. This tool can
be used to read the CMYK
setting of the good photo to
compare with the photo you’re
trying to correct. You can visu-
ally see if the colors are in the
ballpark when you compare
things like grass, streets and
people’s faces.

A flyout menu in the Info
panel allows you to set the
photo to CMYK or Grayscale.

With the quality of photos
from newer SLR cameras, you
shouldn’t need to do much
to the photo, especially if the
photo was taken in a bright
area. So don’t overcorrect.

Most photos need a little
lightening up to run well
on the press. Use Curves or
Levels to do this with a little
bit of lightening in Brightness/
Contrast.

Most newspapers have their
own way of lightening photos,
and this is OK if the photo
comes out good. Those with
high-end cameras that save in
RAW format may open them

is just one of the benefits of being a member of the Oklahoma Press
Association’s Legal Services Plan. Remove the worry of needing
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION’S

LEGAL SERVICES PLAN
1-888-815-2672 or 405-499-0020

that way and lighten the photo
there.

However, not all papers
are lucky enough to have a
high-end camera. But even if
you don’t have a great camera
or are working with a lesser
quality photo, you can still
make it pop.

Most photos can use some
sharpening but be careful not
to overdo it. To use, go to
Filter > Sharpen > Unsharp
Mask.

Use the top Amount slider
and run it up a little. If you’re
seeing halos in high contrast
areas of the photo, bring it
back down. This tool can often
help a blurry photo look better.

At the end of the photo
correction process, convert
to CMYK. You may think the
photo looks flat but that’s only
because monitors are RGB
and don’t display CMYK well.

Convert to grayscale after
you correct the image size and
lighten the photo. If needed,
lighten more and use the un-
sharp mask.

Practice using the info dia-
log box with photos that print
well. This is a good way to
train new people and improve
the overall quality of photos in
your newspaper.

Remember that a truly bad
photo will never be as good as
a quality photo. If you must
use a bad photo, make it gray-
scale and place it on a black-
and-white page of the paper.

Even with all the correct
steps and corrected photos,
there may be times when they
still don’t look good in print.
If this happens, spend some
time trying to find out what
happened and see if there’s a
way to correct it for next time.

OPA Computer Consultant Wilma
Newby’s column is brought to you by
the Oklahoma Advertising Network
(OAN). For more information on the
OAN program, contact Oklahoma
Press Service at (405) 499-0020.



LOUISE HIGHT CAIN, the
former owner and publisher of
the Atoka County Times, died
July 4, 2025. She was 84.

Cain was born December
2, 1940. She graduated from
Atoka High School in 1958.

She married Foster Freder-
ick Cain in 1976. The couple
was married for 28 years
before his death in 2004. Their
marriage marked a powerful
partnership.

DEATHS

Foster, a professional news-
paperman, continued a family
tradition of publishing that
spanned four generations.

Foster moved to Atoka and
purchased the Atoka County
Times in 1972. Together, Lou-

ise and Foster became the driv-

ing force behind the newspa-
per. Louise served as publisher
for many years, overseeing the
production of more than 2,500
issues before retiring in 2023.

When not working, she

enjoyed friends and family.

She was a longtime member

of the Atoka First Baptist
Church, where she previously
served as a Sunday school
teacher. She was also a mem-
ber of the Oklahoma Good
Sam’s Club, serving as the
club’s president in 1997.

Cain is survived by her son

Mark Dale Cain, three grand-
children and one great-grand-
son.

Please donate to the

OKLAHOMA NEWSPAPER FOUNDATION

Donations to the Oklahoma Newspaper Foundation will support its efforts
to improve the state’s newspaper industry and quality of journalism.

DONATE ONLINE AT OKPRESS.COM/DONATIONS/

Or send check to Oklahoma Newspaper Foundation, 3601 N. Lincoln Blvd., Oklahoma City, OK 73105-5499

Remembering our friends & colleagues who died the previous year.

Alex K. Harrison ‘Lyle’ John Louis Charles ‘Chuck’ Darrell Dion
Adwan Becker Spire Sr. Sidney Lake Sumner
June 15, 2024 June 14, 2024 June 4, 2024 July 11,2024 July 1, 2024

The Lawton Constitution
donates to local charities

The Lawton Constitution
was once again able to assist
three local charities, thanks to
a $10,000 gift from the Car-
mage and Martha Ann Walls
Foundation.

The foundation allows
publishers at all Southern

Newspapers Inc.-owned papers

to choose a local non-profit or
non-profits to receive funds
each year.

The Lawton Constitution
split the gift with the United
Way, Lawton Food Bank and
Embrace Hope.

“Walls Foundation gifts
allow our paper to make a
significant impact on non-prof-
its that make our area better
and help local volunteers to
carry out their mission,” said
David Stringer, Constitution
publisher.

“The legacy of the Walls
family is not just one of pro-
moting quality journalism, but
also promoting a deep sense of
caring for the communities we
serve.”

Carmage Walls founded
Southern Newspapers. Martha
Ann Walls served as president
of the company for most of its
history.

In the past 16 years, the
foundation has given more
than $3.6 million to the
communities Walls-owned
newspapers serve, including
Texas-based newspapers in
Galveston, Baytown, Brazo-
ria County, Bay City, Lufkin,
Nacogdoches, Paris, New
Braunfels, Kerrville and Se-
guin; as well as Lawton.

Got
News?

Share news about your
publication with other
OPA members! If you
have a new hire, sales
promotion, contest, or
have received an award
or honor, tell us about it
so we can putitin The
Oklahoma Publisher.

Send your news
or story ideas to

jgilliland@
okpress.com
or call 405-499-0020

OPA STAFF DIRECTORY

ADMINISTRATION
MARK THOMAS

Executive Vice President
mthomas@okpress.com
(405) 499-0033

JEANNIE FREEMAN
Accounting Manager
jfreeman@okpress.com
(405) 499-0027

SCOTT WILKERSON

Front Office/Building Mgr.
swilkerson@okpress.com
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MEMBER SERVICES
LISA SUTLIFF, CAE
Member Services Director
Isutliff@okpress.com
(405) 499-0040

ALEXIS MARSHALL
Member Services Coordinator
amarshall@okpress.com
(405) 499-0035

ADVERTISING
LANDON COBB
Sales Director
Icobb@okpress.com
(405) 499-0022

CINDY SHEA
Advertising Director
cshea@okpress.com
(405) 499-0023

DIGITAL NEWS TRACKING
KEITH BURGIN

Digital News Tracking Manager
kburgin@okpress.com

(405) 499-0026

JENNIFER CATES
News Tracking Staff
jbeatley-cates@okpress.com

SHARON BEUCHAW
News Tracking Staff
sbeuchaw@okpress.com

CREATIVE SERVICES
JENNIFER GILLILAND
Creative Services Director
jgilliland@okpress.com
(405) 499-0028
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Monthly
Public Notice Journalism Contest

sponsored by

Oklahoma Press Service

The contest recognizes a
news story or series that:

(a) highlights the impact of a public notice or the
omission of a public notice,

(b) helps readers understand a specific public
notice, or

(c) explains the consequences of a public body’s
failure to publish a notice in a newspaper.

PUBLIC NOTICE CONTEST RULES

ELIGIBILITY:
Staff at all OPA legal newspaper and general news media
member publications as well as Individual members are
eligible to compete. Entries must have been previously
published in print or on the publication’s website. All entries
will compete together. One entry per writer per month will
be accepted.

HOW TO SUBMIT ENTRIES:
Each month, submit your entry at okpress.com/public-
notice-contest. Attachments should be in PDF format.
Entries may also be emailed (full-page tearsheet) to
amarshall@okpress.com. Include the author’s name, name
of publication and date of publication.

ENTRY DEADLINE:
All entries published in the previous month must be
received by OPA by the 15th of the current month.

AWARDS:
One winner per month will receive a Certificate of
Achievement, a $100 check and recognition in The
Oklahoma Publisher. Annual Sweepstakes winner will
receive a plague, a $200 check and recognition in The
Publisher.

ENTER ONLINE AT:
okpress.com/public-notice-contest

PUBLIC NOTICE

JOURNALISM CONTEST

APRIL 2025 WINNER

THE NORMAN
TRANSCRIPT

Proposals sought for detention
center medical staffing, admin

PAGE 1 APRIL 30, 2025

PAXSON HAWS
Managing Editor

The Cleveland County Sheriff’s Office is soliciting
proposals for medical staffing and medical administration
at the F. Dewayne Beggs Detention Center.

According to the request for quotes
published in the public notice section of
The Transcript last week, each city and
county detention facility in the state is
required to provide adequate health care
to inmates, including medical, dental and
mental health services.

The CCSO and the detention center have faced
significant scrutiny over the past two years following the
deaths of several inmates. Five inmates died in custody in
2024; Nicole Deann McComb on Aug. 28; Daniel Edward
Freeman on Aug. 25; Thomas Sanchez Pesina on May
4; William Kenneth Moore on April 19. In 2025, there
has been one death of an inmate in custody, Jacob Shane
Dieball, 27.

The detention center’s current medical provider is Turn
Key Health, which has provided services to facilities in
Oklahoma and Tulsa County as well as Cleveland County.

Read entire winning entry at
okpress.com/public-notice-contest



